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Overview
This tutorial is a very basic overview of FrontPage Express helping you to get started with your new website.  FrontPage Express is a Hyper Text Markup Language (HTML) Editor.  With it, you can develop a custom website for the Internet.  This purpose of this tutorial is to help you learn how to use FrontPage Express and create your own website. This is by no means a comprehensive tutorial.  However, it will provide you with enough information to create informational and attractive web pages.
Introducing FrontPage Express
FrontPage Express is supplied as part of Microsoft’s Internet Explorer suite and a typical Windows 98 setup.  This editor was first included in version 4 of the browser suite and is one component that has remained the same in newer releases of Internet Explorer.
FrontPage Express offers you two ways to create and edit Web pages. The WYSIWYG editing window is the simplest method, and the one you’re most likely to use if you’re just starting to build Web pages. It instantly shows you what your page will look like once it is published to the Web.

In WYSIWYG mode, simply type directly onto the page, and use the toolbar buttons to change the colour, size, and style of the font, or add elements like pictures or video files. The background colour of your page, the title, margins, and text colours can all be easily specified in the Page Properties dialog box from the File menu.

In addition to WYSIWYG mode, FrontPage Express allows you to view the HTML that it generates, formatted and colour coded so it is easy to read. If you’re familiar with HTML, you can go “under the hood” to edit in HTML mode and instantly see the results on your page. To use this mode, click HTML from the View menu.

Starting FrontPage Express
FrontPage Express is part of a typical Windows 98 setup. To open it, the software can normally be found by clicking Start, point to Programs, point to Accessories, point to Internet Tools, and then click FrontPage Express.

However, if you need to install the software, it is available to download for free from the Microsoft Corporation www.microsoft.com or from alternative sources via Internet search engines such as www.google.com.
Interface
The interface in FrontPage Express is similar to many Microsoft programs. The toolbars along the top are divided up and you can turn individual toolbars off in the View menu.  You can also re-arrange the toolbars by dragging them around the program title bar.  If you want to turn one of the toolbars into a floating toolbar, you can do so by dragging it out of the title bar into the main program area. When you release the mouse button, it will detach and float.
The Toolbar
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(Your tool bar may be arranged differently or have some components missing. You can fix this by choosing View from the menu bar and selecting all toolbars.)   On page 15 we’ve included a quick reference guide to the toolbar for your convenience.   
 

Text
Entering text into a webpage is much like entering text into a word processor. Simply type the text you want to appear and then use the following steps to spice it up.

Layout
The text on your webpage doesn't have to all be in paragraph blocks. You can change a page layout in many different ways:

· Line Break
When you press ENTER at the end of a line of text, the cursor drops down two lines and starts a new paragraph. The only way to get text directly underneath the first line of text is to finish filling up the line and letting word-wrap do the rest (much like this paragraph). But sometimes you want to go to the very next line after only a few words. An example of this is a mailing address:

	Cheshire County Council
County Hall
Castle Drive
Chester
Cheshire CH1 1SF


· This is called a Line Break. To create a line break, simply hold down the SHIFT key and press ENTER. In FrontPage Express, Line Breaks are denoted by a [image: image3.png]


.

· Alignment
You can align text and pictures to the right, center, or left of your webpage. To do this, highlight the text or picture you want to move and click on either the right, center, or left buttons on the toolbar. If you haven't started typing the text, just click on either the right, center, or left buttons and the cursor will move to that part of the page. 

· Indents
You can indent blocks as text as well. To indent some text, click the Increase Indent Icon on the toolbar. To out-dent or unindent some text, click the Decrease Indent Icon on the toolbar. When you indent or out-dent a block of text, the entire paragraph that the text is in is indented or out-dented. So be careful when using indent and out-dent, especially inside of lists. 

· Lists
You can also make lists. Lists are indented and denoted and are especially good for outlines. Here is an example of the two major kinds of lists, the Numbered List and the Bulleted List:
	Numbered List
	Bulleted List

	1. Apples 

2. Oranges 

3. Kiwi 

4. Tomatoes 
	· Dogs 

· Cats 

· elephants 

· Sheep 


To make a list, select either the Numbered List or Bulleted List Icon from the toolbar. Type the text of the first list item. When you hit ENTER, the cursor drops down to the next line (not a new paragraph) and another number or bullet appears for the next list item. To end the list, press ENTER after you've typed the last list item. Then, deselect the selected List Icon. The cursor will then drop down to a new paragraph and will be out-dented to the indent before the list was started. 
Nested Lists
In the case of outlines, you may want to nest lists, or have a list inside of another list. It would look something like this:
	1. Computer Science Department 

· Work Study 

1. Mike Loosbrock 

2. Matt Christians 

· Part-time Employees 

1. Mat Nelson 

2. Bill Heinrich 

· Staff 

1. Bill Bartell 

2. Jeff Lundblad 

3. Jack Iverson 

2. History Department 

and so...


· To build a nested list, start by creating the top most list, or parent. (In the case above, you'd make a Numbered List and type in the first item.) Then to make a sub-list of that item, do the following:

1. Press ENTER after typing in the list item of the parent list. 

2. Click the Increase Indent Icon. 

3. Select the either the Numbered List or Bulleted List Icon from the toolbar. (In the case above, you'd select Numbered List.) 

4. Type in the first item of the nested list. 

To end a sub-list and return to its parent list (In the example above, end the list containing Mike Loosbrock and Matt Christians and get back to list containing Work Study, Part-Time Employees, and Staff), do the following:

1. Press ENTER after typing in the last item of the sub-list. 

2. Either press BACKSPACE twice, or click the Decrease Indent Icon twice. 

Attributes

FrontPage Express allows you to make all the same attribute changes you can make in with a typical word processor. The first step in changing text attributes is to highlight the text you want to modify with the mouse. You can then make the following changes:

· Font Type
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New. To change the font type, select the font you want from the Font Type List Box on the toolbar. (Try not to use a lot of non-standard fonts because if the font is not loaded on the computer where your page is being viewed, the font will appear as the browser default.) 
· Font Style
The style of the text can either be bold, italics, or underline. To change the font style, select one or more of the Style Icons on the toolbar. 
· Font Colour
The colour of the text can also be changed. To change the font colour, select the Text Colour Icon on the toolbar. The Colour Dialog Box appears. Choose the colour you want and click Presto...we mean...OK. 

· Font Size
You can change the font size by clicking the either the Increase Text Size or Decrease Text Size Icon from the toolbar. 
Images
You can insert images (*.gif, *.jpg, *.jpeg) into your webpage. Keep in mind that you need to keep your images relatively small in size, otherwise, your pages will take a long time to download.

To insert an image, put your cursor where you want to place the image and then:

1. Select the Insert Image icon from the toolbar. 

2. The Image Dialog Box appears. Click the Browse Button. 

3. Find and select the image you wish to insert and click OK. 

The image should appear on the webpage. After you have placed the image on the webpage, you can change the attributes of the image by right clicking on the image and choosing Image Properties. 
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The Image Properties Dialog Box appears. Choose the Appearance Tab.
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Alignment
The Alignment property allows you to set how the image is aligned vertically in respect to the line of text it is embedded in. For example: 

	Bottom Align
	Middle Align
	Top Align

	bottom[image: image6.png]


align
	middle[image: image7.png]


align
	top[image: image8.png]


align


You can also align the image horizontally:

	Left Align

	[image: image1.png]CHESHIRE
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Here is an example of an image that is left aligned. The text wraps around the image, which is align to the left.

	Right Align

	[image: image16.png]


Here is an example of an image that is right aligned. The text wraps around the image, which is align to the right.


When you insert an image in text, the image appears where the cursor is when you click the Insert Image Icon. When you either right or left align an image in a line of text, the image defaults to 'top align' in the line you inserted the image. You also horizontally align the image using the Alignment Icons on the toolbar. 
However, you can't centre the image in a line of text, only left and right will work. If you have an image not embedded in text, you can horizontally align it left, right, and centre. This can be accomplished by using either the Image Properties Dialog Box or the Alignment Icons on the toolbar.

left align
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center align
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right align
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Hyperlinks
Links create a connection between more than one of your pages. Links also can connect your page to other pages across the World Wide Web. 
To link to a webpage other than your own, determine where you want to link to (For example, you might want the viewer to click on the words "CNN News" and have them sent to http://www.cnn.com). To do this, first highlight the text, picture, or both, that you want to be linked (in this case, we would highlight the words "CNN News"). Next click the Create or Edit Hyperlink Icon on the toolbar. 
The Create Hyperlink Dialog Box should appear, as below. Choose the World Wide Web tab. Then make sure the Hyperlink Type List Box is set to "http:" on the Hyperlink Type List Box. Lastly, on the line titled URL type the address of the webpage. In this case we would type out http://www.cnn.com. Click the OK and presto you have just created a link that should look and work something like this link: CNN News. 
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To link your own pages together, you first need to determine how the pages are to be connected. For example, you may want the viewer to click on the word "Hobbies", and have it go to a separate page of yours. To do this, follow the same directions as above: highlight the text and click the Create or Edit Hyperlink Icon on the toolbar. 
The Create Hyperlink Dialog Box should appear, as below. Choose the World Wide Web tab. Next, select "(other)" for the Hyperlink Type: On the URL line type the name of your other page. In this case we would type "hobbies.htm". Once that is done you can click the OK and you will have created a link to another one of your pages.
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You may want to include an e-mail link for your page. This will enable the viewers to click on your name and an e-mail program will automatically start with your e-mail address already in the send to line. To do this, you first need to highlight the text you want to link to your e-mail, which for the most part, will probably be your name. Like before you now need to click the Create or Edit Hyperlink Icon on the toolbar.
The Create Hyperlink Dialog Box should appear, as below. Choose the World Wide Web tab. Make sure the Hyperlink Type is set to "mailto:" on the Hyperlink Type List Box. On the line titled URL type the actual e-mail address. If the e-mail address, for example, was rob.ashcroft@cheshire.gov.uk, we would type out "rob.ashcroft@cheshire.gov.uk". Now click the OK and you have just created a link for your e-mail.
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Saving your page
Select "Save" from the "File" menu. Type in a suitable name under "Page Title" and click the "As File" button of the "Save As" dialog box. The "Save As File" dialog box appears: create a new folder for your Web site and save the document in there.  We recommend that you save your home page file as ‘index.htm’.  
Using tables

HTML does not format pages in a fixed manner. In other words, the page looks different depending on the size of the browser window and the layout will change dynamically as you resize the window. Sometimes, however, you don't want pages to look different at different sizes and the easiest way to restrict the layout is to use tables. Like images, tables can be set to have 0 (zero) borders so that users never see them. The following text is set inside a table. Adjust the size of the browser and you'll see that it works in a different way to the other pages in this Companion. To make it more obvious how it works, we have left the table border set to 1 (one) so it is visible.
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To insert a table into the page, click on the table icon and it will pop up a grid that you can drag out to define the number of cells in the table. If you have problems using the icon, then you can insert the table from the Table menu. If you do it in this way, then a dialog box will pop up asking you to define the properties. 
You can choose how many columns and rows make up the table. If you insert a table with only one cell, then you can define the width of the table and insert the text and pictures into the table and as long as you have set that width in the box, then you know that the way that the page looks will be fixed. 
It's sometimes better though to use tables with additional cells because you can set the alignment and vertical alignment of cells and use them to put a navigation bar on one side and to fix text with images.
This is best illustrated by trying it for yourself. Set a table with two columns and two rows to make four cells. Then insert a substantial amount of text in one cell and a picture in the one next to it and do the same with the two lower cells. When you view this in a browser, you'll see that the text from the first doesn't continue down to wrap around the second picture.
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You can go further and define the parameters and dimensions of individual cells. To do this, right click on the cell you want to change and choose Cell Properties. There you can set defined widths and more. Tables appear more complex than they actually are and a little experimentation should make sense of the options. 

Toolbar Quick Reference 
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